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Introduction to Cascade Server (web content management system) 

The SNC web site is being produced using a Content Management System (CMS) called Cascade Server. This 

system allows College units to manage their own web areas using a browser-based tool that requires no special 

software or knowledge of HTML. It also allows for a consistent look across the entire web site. 

Logging in to Cascade Server 
To log in, go to http://www.snc.edu/cms or http://www.snc.edu/cascade and log in with your 6-character network 

login ID & password. Only those who have been given access to Cascade can log in. To obtain access, your 

supervisor must complete a Web Access Application Form at http://www.snc.edu/techsupport. You will be added 

to the discussion list “cmsusers@snc.edu,” which is used to inform you of system upgrades, training, etc. 

The page you will see when you first log in to Cascade Server is the “dashboard” (not pictured). Most users will 

not use most of what’s on this page except for the “Messages.” Most of your messages will be notes from the 

system regarding something that you have published. You really only need to read these messages if something 

goes wrong when you publish. The other useful thing on the Dashboard is the Recycle Bin (see pg. 3 for details). 

To return to the Dashboard at any time, click Home in the blue menu bar in the upper left corner of the screen. 

The Cascade Server screen 
The left-hand column lists all of the web site folders to which you have access. Most people will only see a few 

folders. To open a folder, click once on it. (Note that because Cascade is web-based, there’s no double-clicking.) 

In the illustration below, the techsupport folder is open and you can see the other folders and files that are inside 

of it. Those with the blue page icon  are web pages. Note that they do not have “.htm” or “.html” file 

extensions. The system adds the “.html” for you later, when you publish the page (see pg. 7 for more about 

publishing). To view a file, click once on it. In the illustration, the file named helpdesk has been selected and is 

shown on the right side of the window in “layout” view. Layout view is the default view that you get when you 

click on a file. It shows you how the entire file looks, and includes some small icons which you can ignore. 

“Preview” view is the same as Layout view, but without those icons. Notice the blue menu bar at the top (Home, 

New, etc.), the tabs below (View, Edit, etc.), and the darker blue menu bar below the tabs (Layout, Preview, 

etc.). These functions will be described later. 

 

http://www.snc.edu/cms
http://www.snc.edu/cascade
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Naming files & folders 
Important: On the web, file and folder names are more restrictive than with regular files. In Cascade Server 

and on any web server, file and folder names should contain only lower case letters, numbers, and if necessary, 

hyphens (-). Web file and folder names should never contain spaces! When naming files in Cascade Server, do 

not put “.htm” or “.html” at the end (the system will add “.html” when the page is published). Also, note that 

Cascade Server does not allow you to have a folder and a file in the same location with the same name. Finally, 

remember that your home page must be named “index” – do not rename this file! 

Renaming files 

If at all possible, try to permanently name files when you create them, so as to avoid renaming them later. If 

you do rename a file, follow these steps to ensure that there are no “orphaned” files left on the server: 

1. Unpublish the file you intend to rename: 

a. In the column on the left, click on the file you wish to rename, then click the Publish tab. 

b. Under Destination, leave both “snc.edu/live web site” and “snc.edu/test web site” checked. 

c. Change the “Publish Mode” from Publish to Un-publish. 

d. Click the Submit button. 

2. Rename the file: 

a. In the column on the left, click on the file you wish to rename, then click the Move/Rename tab. 

b. In the “System Name” box, change the name. 

c. Click the Submit button. 

3. Publish the renamed file as described on page 7. 

Creating new pages 
To create a new page, copy a page from the same folder. The new page will take on all of the characteristics of 

the copied page, including the navigation. Because you can’t change the navigation, be sure to copy a page that 

has the navigation you want, rather than one that has the content you want (to copy content from another page, 

just copy & paste it). Do not copy pages from one top-level folder to another, or you’ll end up with the wrong 

navigation! See page 6 for more about navigation. 

1. In the column on the left, click once on the page you want to copy, then click the Copy tab at the top. 

2. In the “System Name” box, give the page a new name. (Note that the fields labeled in bold with the 

small yellow star are the only ones that are required.) See above for information on proper file names. 

3. To put the new page into another folder, click on the folder name next to “Parent Folder,” choose the 

desired subfolder, and click Confirm. Note that pages in subfolders will not have the same navigation as 

the pages in the main folder. Each subfolder has its own navigation based on the pages in that folder. 

4. Click Submit. If the spell-checker or link-checker come up, review the results, then click Submit again. 

5. Once the new page is created, be sure to change the Display Name, Title, and Page Header (see pg. 3). 

Creating folders 
1. In the column on the left, click on the folder inside of which you want the new folder. 

2. In the blue menu bar at the top, go to New – folder. 

3. In the “System Name” box (again, the bold, starred fields are the only ones required), enter a name for 

the folder. See the “Naming files & folders” above for information on properly naming folders & files. 

4. If you don’t want this folder to be published when the folder above it is published, uncheck “Include 

when publishing.” You should do this for test folders & folders whose contents aren’t ready to go live yet. 

5. Click Submit. 

Deleting pages 
To delete a file or folder, click on it on the left, then click the More tab at the top and choose Delete. When the 

confirmation screen comes up, read it carefully to be absolutely sure you understand what’s being deleted, if 

it’s being unpublished, and if so, from which destinations. When deleting files that have been published, be sure 

to unpublish them too, so that they’re not “orphaned” on the server. The Relationships section tells you if any 

pages on your site have links to this page that would be broken by deleting & unpublishing it. Be sure to 

remove those links before deleting the page. 
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Recycle Bin 

Cascade’s Recycle Bin contains items that you have deleted in the last 15 days. To access the Recycle Bin, click 

on Home to go to your Dashboard, then click on Recycle Bin. To restore a file, click the green circular arrow in the 

“Actions” column on the right. To restore multiple files, check the boxes to the left of them, then from the “With 

Selected:” drop-down menu at the bottom, choose Restore. 

Editing page properties 
The top and left sides of each page are pre-defined – you cannot alter those areas except to specify which pages 

appear in the navigation menu. The white area on the right is your work area, where you will put your text and 

pictures. In editing mode, you will only see that part of the page. 

To edit a page, click once on it on the left, then click on the Edit tab. When the edit screen opens, the HTML code 

of the page will be displayed briefly; wait until it displays a screen like the one pictured below. 

 

Below the Edit tab, shown here, you will see a dark blue menu bar with 4 options: Content, Metadata, System, 

and Configurations. The important aspects of these options are described below. 

Content: This is the main editing screen, where you create & edit the page content. On this screen you will find 

two very important boxes which must be filled in: 

*Display Name: This is the name of the page that is used in the web site navigation menu on the left. It is 

not used anywhere else. This may or may not be the same as the Title or Page Header (described below). 

*Title: This is the title of the page that displays in the web browser’s title bar, and is used by search engines 

and when the page is bookmarked. Do not include “St. Norbert College” – the system will add that for you. 

You don’t need to include your department name except when necessary to avoid confusion with other pages 

on the SNC site. (e.g., The title “Contact us” could be ambiguous – does it mean contact your department or 

contact SNC? – so there you’d want to use the department name in the title, like “Contact Career Services.”) 

System: Under System, you can ignore everything except: 

Include when publishing: Normally you will leave this checked. It means that the page will be published 

to the server (made live) if the folder that includes it is published. If for any reason you want to keep a page 

from being published (e.g., if it’s not finished yet, or is just a test page), uncheck this box. 

Include when indexing: Leave this checked. 
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Metadata: Under Metadata, you can ignore everything except: 

*Page Header (optional): The Page Header appears at the top of the page in larger green text. It’s unusual 

because instead of typing it on the body of the page, you put it in the Page Header box, and you can’t see it in 

the WYSIWYG (What You See is What You Get) editor. You see it after you submit the page, on the View tab. 

Include in Navigation: If you don’t want the page in your navigation menu on the left, choose No. For 

more about editing the navigation menu, see the “Navigation menu” section on page 6. 

Configurations: Do not change anything on this screen! 

*Starred items above are the various names each page can have, which can be somewhat confusing. 

Creating & editing page content 
To edit a page, click once on it on the left to view it, then click on the Edit tab. When the edit screen opens, the 

HTML code of the page will be displayed briefly; just wait until it displays a screen like the one shown on pg. 3. 

If only the HTML code is displayed and a screen like the one below never appears, then your browser is not 

compatible with Cascade Server and you will need to use a different one. We suggest Firefox 

(http://www.mozilla.com). When finished editing, click the Submit button at the bottom to save your changes. 

The editing and formatting tools are very similar to those in Microsoft Word and other programs, so most of the 

buttons should be self-explanatory (bold, italics, centered, etc.). If you’re not sure what a particular button does, 

hold your mouse pointer over it without clicking. The “Styles” and “Format” drop-down menus contain various 

formatting options for headings and subheadings. 

To gain more screen space when editing, click the Toggle fullscreen mode button on the right side of the toolbar.  

Click it again to return to the normal view. 

Saving your work 
To save your changes, click the Submit button at the bottom of the screen (you may need to scroll down to see it). 

If the spell-checker or link-checker come up, be sure to click Submit again after reviewing the results. Always 

remember to click Submit to save your work before leaving the screen. If you see a message saying “Are you 

sure you want to navigate away from this page?”, pay attention! Cascade is warning you that you’re about to do 

something that may cause you to lose your work. 

If you’d like to save you work but want to continue editing the page, click the Save Draft button. This saves your 

work but leaves you in editing mode. Your changes will not be applied to the active version of the page until you 

click Submit. This can offer protection against computer/browser crashes, and may be useful if working on a page 

for a long time. Note that once you click Save Draft, you’ll then also have Update Draft and Discard Draft buttons. 

Tip: It is recommended that you use 

Firefox’s tab feature when using 

Cascade Server. If, while working on a 

page, you need to view another page, 

just open a new tab (CRTL+T or File – New 

Tab). You can use the new tab to visit 

another web page, or to view a different 

Cascade Server screen or page. To open a second Cascade tab, open a new blank tab, click back on your first 

Cascade tab, then drag the page icon from the address bar (in front of the “http://”) down to the new tab, as 

shown in the illustration above. 

Note that submitting a page only saves your changes in Cascade – it does not make them live on the web site. 

In order to make your changes live, you must publish the page. (See the “Publishing” section on page 7.) 

Comments: You may wish to add comments when you edit pages. Comments do not appear on the web page, 

but they are saved with the file and displayed in the Versions list. You can use this for brief notes about why 

you edited the file, like “Updated staff listing,” which can be especially useful if more than one person 

maintains a web area. To add comments, scroll down to the bottom of the Edit screen, click on the “Advanced 

Options » ” link, and enter comments in the “Version Comments:” box. Click the Submit button to save them. 
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Versions 

Each time you click Submit, Cascade Server saves a version of the page (up to a maximum of 40 versions), so you 

can revert back to an earlier version of the page if needed. Note that when you delete a page, all versions are 

deleted along with it. To view the available versions, with the date they were last modified and by whom: 

1. Click once on the file on the left to view it, then click on the More tab and choose Advanced. 

2. To view one of the other versions, click on it in the Path column. 

3. To browse through versions, use the Newer and Older links at the top. 

4. To compare an older version to the current one, click on Compare with Current. 

5. To restore that version (make it the current version), click on Activate. 

6. To return to the Versions list, use your browser’s Back button. 

7. To go back to the current version without activating an older one, click on Current. 

Copying & pasting into Cascade Server 

To avoid formatting problems, use one of the following techniques. (For 

Mac instructions, see http://www.snc.edu/techsupport/web/tips.html.) 

Using Cascade’s Paste as Plain Text feature 

1. Copy the text you wish to paste onto a Cascade Server page. This 

can be from a web page, Word, etc. 

2. In Cascade, click the Paste as Plain Text button. If this is the first time you’ve used the feature, you will 

see a pop-up notice about how it works. Note that this button does not actually paste the text, it just 

turns the plain-text pasting feature on. It seems to remain on until you copy something else. 

3. On the Cascade edit screen, place your cursor where you want the text and go to Edit – Paste (or Ctrl+v). 

Your text will be pasted into the page without the formatting. Unfortunately, all of the line breaks 

(enters/returns) are usually removed too, so you may need to edit the text to separate it again. 

Using Notepad 

1. Copy the text you wish to paste onto a Cascade Server page. This can be from a web page, Word, etc. 

2. Open Notepad (Start – Programs – Accessories – Notepad). 

3. In Notepad, go to Edit – Paste (or Ctrl+v). You will see your text without the formatting. 

4. In Notepad, go to Edit – Select All (or Ctrl+a) to highlight the text. Go to Edit – Copy (or Ctrl+c) to copy it. 

5. On the Cascade edit screen, place your cursor where you want the text and go to Edit – Paste (or Ctrl+v). 

Links 
1. Select the text that you want to be linked (where people will click) and click the Insert/edit link button . 

 To link to another page that you have access to in Cascade Server, click the  button. In the 

window that pops up, select the page you want to link to and click the Confirm button. 

 To link to a non-SNC web site or a page that you do not have access to in Cascade, click the External 

button. In the “Link” box, type or paste the address of the page you want to link to. Use the full 

address, including the “http://” at the beginning (but make sure that http:// isn’t duplicated). 

 To link to an e-mail address, click on the External button. In the “Link” box, type or paste the e-mail 

address preceded by “mailto:” (without the quotes), e.g., mailto:donald.duck@snc.edu. 

2. Click the Insert button. Do not change the “Target,” “Title,” or “Class” boxes. 

Linking within the same page (anchors) 

1. To insert an anchor (the place on the page you wish to link to), put your cursor where you want the 

anchor and click the Insert/edit Anchor button.  

2. In the “Anchor name” box, type a name for the anchor with no spaces (e.g., myanchor) and click Insert. 

The anchor will be represented by a little  icon, but it will not appear on the live version of the page. 

3. To link to the anchor from the same page, highlight the link text and click the Insert/edit link button.  

Do not copy & paste text from 

Word or web pages directly into 

Cascade. It may look okay, but 

it will cause problems with the 

page formatting. Instead, use 

the technique described here. 

http://www.snc.edu/techsupport/web/tips.html
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4. Under Internal, in the “Anchor” box, type the name of your anchor (e.g., myanchor). 

5. Click the Insert button. 

Linking to an anchor from another page 

1. Insert the anchor as described in step 1 above, then Submit the page. 

2. Edit the page from which you wish to link to the anchor. 

3. Highlight the link text and click the Insert/edit link button.  

4. Under Internal, click the  button. In the window that pops up, select the page you want to link to and 

click the Confirm button. In the “Anchor” box, type the name of your anchor (e.g., myanchor). 

5. Click the Insert button. 

Images 

Uploading images 

Images must be uploaded to Cascade before you can use them on a page. Put all image files in your “images” 

folder. You can create subfolders inside of the “images” folder if you like. You can also upload multiple images 

at once by putting them into a Zip file. See Cascade Server: Image Editing & PDF Files for details. 

1. In the column on the left, click on the images folder to highlight it. 

2. In the blue menu bar at the top, go to New – file. 

3. In the Data section, below the large box, click the Browse button next to “File Upload.” 

4. Choose the file and click Open. 

5. Click the Submit button. When the upload is complete, you will see the name of the image appear in the 

file list on the left and a preview of the image on the right. 

Tip: To see thumbnails of all of the images in a folder, click on the folder, the click Gallery in the blue menu bar. 

Inserting images 

1. Be sure that you’ve already uploaded the image you wish to insert (instructions above), then open the 

page in edit mode and click where you want the image. 

2. Click the Insert/edit Image  (tree) button. In the window that pops up, click the orange Browse  button. 

Another window will pop up for you to select the image. 

3. In the column on the left, locate the image you want and click once on it. Click the Confirm button. 

4. Back in the first pop up window, you must fill in the Alternate Text box. Alternate text should describe the 

image very briefly, e.g., “Main Hall” for a photo of Main Hall. 

5. Always leave the Width/Height boxes as is so the image is not distorted. 

6. To set border width, spacing around the image, or image alignment (useful for changing how the text 

wraps around the image), click on Advanced in the blue bar at the top of the window. 

7. If you will be making the image a link, set the Border Width to 0 (zero). 

8. Click the Insert button. 

9. To edit an image after it has been inserted, click on the image, then click the Insert/edit Image  button. 

Uploading PDFs & other non-html files 
PDF files have to be uploaded to Cascade Server before you can use them on your site. If there are other types 

of non-web page files that you need for your site, you would upload them in the same way. For information on 

creating PDF files, see the handout Creating PDF Files with PrimoPDF, at http://www.snc.edu/techsupport. 

1. In the column on the left, click on the folder in which you wish to put the file. 

2. In the blue menu bar at the top, go to New – file. 

3. In the Data section, below the large box, click the Browse button next to “File Upload.” 

4. Choose the file and click Open. 

5. Click the Submit button. When the upload is complete, you will see the name of the image appear in the 

file list on the left, and Cascade Server should display the file on the right side. 

If you need to upload a new version of a PDF, click on it on the left, click the Edit tab, and repeat steps 3-5. 
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Navigation menu 
You will notice that when you’re editing pages, the navigation menu on the left side of the page is not visible 

(see picture on pg. 3). You cannot control the navigation menu directly; you do so through the properties of the 

pages in the folder. Whether or not a page appears in the navigation menu is controlled by the “Include in 

Navigation” option on the Metadata screen. If that’s set to Yes (the default), the page’s “Display Name” will 

appear on the navigation menu for all pages in that folder. To change the order of items in the navigation menu: 

1. In the column on the left, click on your folder. 

2. On the right, you will see a list of the folders and files in your main folder. To sort them by order 

number (2nd column), click on the word Order at the top of that column. 

3. The items with the page icons  are your web pages. The order that they’re in in this list is the order in 

which they appear on the navigation menu. To change the order, click the arrows in the Actions column 

to move pages up or down. You only need to move the pages, not the folders (it doesn’t matter where the 

folders are; if you wish, you can move them to the bottom of the list to get them out of the way). 

Note: If you rearrange the navigation menu or do anything else that affects it (e.g., deleting a page, changing 

the Display Name of a page, adding a page, etc.), the system will automatically update all of the necessary 

pages, but in order for the updates to be made live on your site, you must republish all of the effected pages. 

Departmental contact information 
Department contact information appears on each page. The contact e-mail address for the department must be 

a College departmental e-mail address. Personal e-mail addresses and non-SNC e-mail address are not allowed. 

To access the departmental contact information for your site, click on your folder, then click the Edit tab. 

Publishing 
Submitting a page only saves it in Cascade Server – it does not make it live on the SNC web site. In order to 

make pages live, you must publish them. Any time you make a change to your folder or page(s) in Cascade 

Server, you must republish all effected pages in order for the change to be live.  

Live web site vs. test web site 

Pages can be published to the test web site (wwwtest.snc.edu), which is only accessible from on campus to those 

who know the address, or to the live web site (www.snc.edu), which is available to the whole world. You may 

want to publish your pages to the test web site and view them there first before publishing them to the live web 

site. However, if you make only minor edits, you may choose to publish directly to the live web site. 

How to publish 

1. To publish one file, click on it in the column on the left, then click the Publish tab. 

2. Under Destination, choose whether you’re publishing to the live web site or the test web site. Both sites 

are checked by default, so you need to uncheck the “snc.edu/live web site” box if you’re not ready to 

make the page live, or the “snc.edu/test web site” box if you’re publishing directly to the live site. 

3. Leave the “Generate a publish report message” box checked and click the Submit button. 

4. To publish more than one file at the same time* to the live site only, click on the folder, then on the 

right side, check the boxes next to the files you wish to publish. At the bottom of the file list, from the 

“With Selected:” drop-down menu, choose Publish. When it asks “Are you sure you want to publish these 

# assets?”, click Submit. Note that this method publishes to the live site only. 

*Please do not publish your entire folder, as that creates a lot of unnecessary extra work for our servers. 

5. If you published to the test web site, preview your page by going to http:// wwwtest.snc.edu/yourfolder/. 

When to re-publish pages 

Whenever you change anything that 

affects the navigation menu, Cascade 

Server will automatically update all of 

the necessary pages, but then you 

must re-publish all of the pages 

containing that navigation.  

Be sure to re-publish all of the affected pages when you: 

 add a page to the navigation menu 

 delete a page that was on the navigation menu 

 change the Display Name of a page on the navigation menu 

 change the order of items on the navigation menu 
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Broken links 
In Cascade Server, when you save and publish pages, you may be notified of broken links to files within your 

Cascade folder. At times, links to other areas may be reported as broken even though they will actually work 

once published to the live web site. It may be difficult to determine which links are this type, and which 

actually contain errors that must be fixed. Separate from Cascade, broken link reports are generated on the 

server every weekday and sent to the departmental e-mail address (e.g., dining@snc.edu). Make sure that 

whoever receives your departmental e-mail forwards those broken link reports to you. Cascade Server does not 

check external links (those to non-SNC sites), but the broken link reports do. For more information about fixing 

broken links, see http://www.snc.edu/techsupport/web/brokenlinks.html.  

Assistance and questions 
If you have any questions or need more information, contact the Help Desk at 920-403-HELP (4357) or 

helpdesk@snc.edu. The Help Desk is for St. Norbert College students and employees only. 

http://www.snc.edu/techsupport/web/brokenlinks.html

